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Multi-inverse method software package
© 2004 Atsushi Yamaji '
All rights reserved

Disclaimer of @afmnty ;

This software package is free. Free of charge software is provided on an “AS IS” basis, without warranty
of any kind, including limitation the warranties of merchantability, fitness for a particular purpose and
non-infringement. The entire risk as to the quality and performance of the software is borne by you.
Should the software prove defective, you assume the entire cost of any service and repair.




ssor?. If some faults are observed to cut other fauits atan

tcrop, we are able to determine the order of faultmg of

em. And, we can estimate the order of the stresses that

¢ thought to be responsible for the faults. Otsubo etal. [5]

e such a technique to study the stress history of an area.

e multiple inverse method can be used to study paleo-
in folded sedlmentary rocks or tilted rock masses
bcddmo tilt test of stresses [16].

pnnc1ple of the multlple inverse method is described
] and Appendix B of this document3

Installation

is the mmxmal system conﬁguraﬁon reqmred to use
s software package:

Pentium (200 MHz).
128 MB RAM.

10 MB free disk space.

- Windows XP/ME/ZOOO/QS/N’M.O operaﬁngsystem.

is very easy to install the main and post processors in
ur computer, as the installation doe’s‘ not alter the registry

I Several articles of the authors used the name “multi-inverse method”

ich is synonymous with ﬂ1e multtple inverse method.
2See §4.3.3 for details. -
31 the number of faults is small say Iess than ten, the Gmkgo method

an option to investigate possible stresses compatible fo given hetero-

eous fault-slip data [15]. The method is a kind of “colored dihedra
method™, and its free software is not included in this software package but
s available from the author’s web page. ‘

of the Wmdows operanng system All the soﬁware compo-

open dialog pops up to prompt the user to select a data
- file. Choose an appropriate data file.

2. Specify an output file name through a save dialog.
The program appends automatically the file extension
“ mi4”. If you specify an existing file, you should an-
SWer yes or no ona console wmdow to conﬁrm the :
overwntmg

3. Input the uumber k through the console window. The :
program accept an integer in the rango 2<k<8, buta
k=4or5is recommended for many cases.

Once the parameter is input, the program starts calculanon.
The lines “Input : sampledata” and “Output : test” indi-
cate that the data file is “sampledata fdf” and the results are
stored in the file “test mi4”. The console wmdow closes
when the computation is completed.

The time of computation depends on: NV and k, and on
the power of your computer.” The program iterates stress
inversion many times. The number of iteration equa}s the
binomial coefficient

N!

YT V- A

F 1gure 2 shows the time and computer memory needed for
processing. - ; :

The ﬁactwnal nm'_nber “100(}/2092” in Flgure 1 reports ;
the status of the computation. Tho denomlnator quals ~Cy,

A1t is possible to launch the executable files from the “Start” menu.
Consult the Help of the operaung systcm for the procedure to regmter the o
executable files to the menu. o

5See Appendix A for this format.
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Figure I: Console window of the main processor.

and the numerator indicates the number of completed iter-
ations.

The present version of the main processor has the limita-
tion yC; < 2,147,483, 647, because the program uses 32-
bit signed integers to count the iterations. This limitation
will be removed in a future version of this main processor
by utilizing 64-bit ones. If N is large, specify a smaller k£
not to exceed the limitation.

4 Post processor

4.1 Basic operations

The post processor has many functions, among which the
main one is to visualize the result of the computation by
the main processor. In this section, the procedure for the
visualization is briefly explained. Other functions are in-
troduced in §4.3.

The post processor has the name “MI Viewer”, and has
the executable file “miv4.exe”. The program has the main
and data windows: the main window has the name “MI
Viewer” on its title bar (Figure 3), and the other has the
title “Fault-Slip Data” (Figure 4).

When the post processor is launched, the main window
lies on the data window. Choose items in the “Window”
menu on the main window or type on the key-
board to bring the data window on the main one.

Follow the steps below for the visualization.

1. Run the executable file.

2. Choose one of the files that were output by the main
processor by clicking the “File” menu and then the
“Open” submenu on the main window. An open dia-
logue opens by these operations. If the file is loaded,
the fault-slip data contained in the file are shown on
the data window.

3. Click the “Draw” button on the main window, then the
result of the multiple inverse method applied to the
fault-slip data is visualized on the paired stereograms
on the main window (Figure 3).

4. Click the “File” menu and click the menu item “Exit”
to terminate the program.

4.2 Visualization

Main window The paired stereograms on the main win-
dow show the principal orientations of stresses by lower-
hemisphere, equal-area projection (Figure 3). Each of the
symbols that have heads and tails like tadpoles plotted on
the stereograms represents a state of stress®. In what fol-
lows, we use the term “tadpole symbol”. The color of a

symbol denotes the stress ratio

Op — 03
o=——

0<d<1).
g — 03

6The term “state of stress” is defined in Appendix C.
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Figure 2: Time of computation and memory needed by the main processor for calculation. The data shown here were measured with
a personal computer (Pentium 11, 300 MHz, 128 M bytes of memory).

[i%i M1 Yiewer [ sampledata.mi4 ]
File Edit Stress Window Help
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Az :323.6

Figure 3: The main window of the post processor, MI Viewer, visualizing the content of the file “sampledata.mi4”, which the main
processor output from the “sampledata.fdt” included in this software package with the parameter k = 5.

We use the sign convention that compression is positive and
ORE< 0 < ) -

Values of this ratio are indicated by 11 colors with an
interval of 0.1. There are color bars just below the menu
bar and under the stereograms. The color scheme can be
freely changed, but the violet and red indicate ® = 0 and
1, respectively, in Figure 3. And, for example, ® = 0.2 is
represented by the third color from the left in the color bar.

Clusters of the tadpole symbols with the same color and
same orientation and length of tails represent significant
stresses for a given set of fault-slip data. A tadpole symbol
represents a state of stress. On the left stereogram, position
of the head of a tadpole symbol indicate a o) orientation,

and the azimuth and plunge of the o; orientation is desig-
nated by its tail. The length of a tail is drawn proportional
to the remainder (90°—plunge). The steeper the o73-axis, the
shorter the tail is. The correspondence between the length
and plunge is shown by the ten gray tadpole symbols plot-
ted between the stereograms, where the tadpoles with the
longest and shortest tails indicate plunges at 0° and 90°.

The role of the head and tail is inverted on the right stere-
ogram. That is, the position of the head of a tadpole symbol
on the stercogram indicates the o3 orientation.

The two values after “Az : ” and “Pl : ” in the status bar
at the base of the main window (Figure 3) show the azimuth
and plunge of the orientation of the position of the mouse
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Figure 4: The data window of the post processor, MI Viewer. The table in this window shows the fault-slip data processed by the
present method. In this case, the data in the “sampledata.fdt” are shown. The same data are shown with the lower-hemisphere stereonet.
One fault datum is highlighted by red lines in the stereonet, because the datum is indicated at the first line in the list and the first column
of the line had been clicked. The column is highlighted by gray backgroud.

pointer on the stereograms. When the pointer is on the left

stereogram, “sigmal” is indicated on the status bar. If it is
on the right stereogram, “sigma3” is indicated. Other items
shown in the status bar is explained in the next section.

Data window The data window has three panels (Figure
4). Fault-slip data are shown in the stereonet occupying the
upper left panel, and listed in the right panel in the FDT
format. At the upper left corner of the former panel, the
position of the mouse pointer is shown by the azimuth and
plunge of the position in the stereonet. The histogram in
the lower left panel shows the frequency of the angular mis-
fits between observed and theoretical slip directions of the
faults. The latter directions are calculated with a state of
stress designated on the main window. The usage of this
histogram is explained in the next subsection.

If a line in the list is clicked, the corresponding fault is
high lighted by red lines on the stereonet. Just before the
graphics shown in Figure 4 was captured, the first datum in
the list had been clicked. It is easy to see the correspon-
dence between plotted symbols in the stereonet and data in
the list. The button “Refresh Sterconet” is to switch off the
highlight.

4.3 Menu items

The post processor has various functions to help analysis.
You can use those functions interactively through the main

and data windows.
4.3.1 File menu

= Open
 Export Image
o= Save Coordinates 4

L Esit

sampledatab.mid

First time you run the post processor, the last item in the
“File” menu is “Exit”. If a file is loaded, the file name is
automatically recorded in the text file “prevfiles.txt”, which
is stored in the home directory of the post processor. Next
time you run the program, the file names are appended be-
low the “Exit” as dynamically created menu items, with
which you can access to the files.

[Export Image] The graphics shown on the main win-
dow can be saved as enhanced metafiles with the file ex-
tension “.emf”. You can decorate or modify the files with

ey pegd

e o e
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Figure 5: The cartesian coordinates O-123 used in the multiple
inverse method.

a drawing software. To do so, choose the “Export Image”
from the “File” menu, then a save dialogue appears. The
graphics can be saved as JPEG images, also. You have the
option on a save dialogue.

[Save Coordinates] Each tadpole symbol indicates a
state of stress. You can file the states represented by plotted
symbols in the main window to text files by choosing the
item “Save Coordinates” from the “File” menu.

The item has two submenu items “Principal axes and
stress ratios” and “Reduced Stress Tensors”. When the for-
mer is chosen, the azimuth and plunge of the o- and o;-
axes and the stress ratios are saved. Each line in the text
file corresponds to one tadpole symbol.

If the latter submenu is chosen, the six independent com-
ponents of reduced stress tensors’, o7y, 0712, O3, 022, 023,
o33 are saved. In this case, the cartesian coordinates shown
in Figure 5 is used.

Copy
43.2 Edit menu

[Copy] The graphics shown on the paired stereograms is
stored in the clipboard by choosing the “Copy” item from
the “Edit” menu. You can edit the picture with a drawing
software.

E? Designate by Mouse
@ Desienate an Axis throueh Keyboard

Enhance Factor »
Digpergion Factor ¥
&= Tadpole Symbal 4

W1 Chanee Colors

fverage and Spread

43.3 Stress menun

[Designate by mouse] and [Designate an axis through
keyboard] The post processor has the function of a sim-

7See Appendix C for the explanation of the reduced stress tensors.

ple simulation to calculate the theoretical slip directions of
faults based on the Wallace-Bott hypothesis® for a specified
state of stress (Figure 6). The angular misfits between their
theoretical and observed ones are also computed.

To use the function, you have to specify a state of stress.
The items “Designate by mouse” and “Designate an Axis
through Keyboard” in the “Stress” menu are available for
this purpose. A state of stress is defined by the o) and o3
orientations and a stress ratio. The former item allows you
to specify these data only through mouse clicks. The other
item prompts you to input one of the orientations through
the keyboard.

If the former item is chosen, the tip of the mouse pointer
is encircled when the pointer is on the paired stereograms
(Figure 7). At the same time the right most box in the status
bar is filled by the sign “Designate 1st Axis”, indicating the
program is in the first mode to designate the first stress axis.
The open circle moves with the tip of the mouse pointer.
The pointer is placed on the left stereogram in Figure 7. On
the other stereogram, a great circle is drawn so as to have
the pole parallel to the orientation the open circle indicates.
The great circle moves corresponding to the movement of
the pointer. Place the circle on a cluster, then click the left
mouse button to designate the principal orientation. This
operation fixes the open and great circles, and cues the pro-
gram in entering the second mode to designate the other
stress axis.

In the second mode, another open circle is drawn on the
fixed great circle. The circle glides along the great circle
with the movement of the mouse pointer. Place the open
circle at the cluster you have noticed, and click the left
mouse button to designate the principal orientation. Then,
then the program enters the third mode to receive the stress
ratio.

You can designate the stress ratio by clicking one of the
color boxes above the paired stereogram. The click termi-
nate all the modes to designate a state of stress, and cue the
post processor to calculate the theoretical slip directions of
the faults under the state of stress just you have specified.

If the option “Designate an Axis through Keyboard” is
chosen, the post processor receives the first stress axes
through the yellow panel shown in Figure 8. Input the az-
imuth and plunge of the o7 - or o3 -axis, and push the “Con-
firm Parameters” button to terminate the first mode. The
other stress axis and stress ratio are designated by the same
steps with those described above.

As soon as the designation of a state of stress is com-
pleted, the post processor calculates the theoretical slip di-
rections of the faults, and plot the directions on the stere-
onet in the data window (Figure 6). At the same time the

8See Appendix B for this hypothesis.
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Figure 6: Data window showing the sample data attached with this software package and their theoretical slip directions under the
state of stress that has the stress ratio @ = 0.3 and the o, and o7; orientations indicated by the symbols ~ and =, respectively, on the
stereonet. The orientations and the stress ratio are shown by their azimuths and plunges at the lower left of the stereonet.
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Figure 7: Part of the main window when it is in the first of three
modes to designate a state of stress. The first mode is defined to
designate one of the stress axes.

Lym MI Viewer [ sampledata5 mi3 ]
File Edit Stress  Window Help
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+ Confirm Parameters | ' *

Figure 8: A principal orientation can be input from keyboard
using this panel.

program calculates the angular misfits between the theo-
retical and observed slip directions. The misfit for each
fault is shown in the right most column in the data list.
The histogram in the same window shows the frequency
of the misfit angles with the bin width of 10°. The program
paints the first three bins brown, olive and pale green. The
same color scheme is applied to the background of the right
most column of the data list and to the symbols represent-
ing faults.

The misfit angles are graphically shown also by the
tangent-lineation diagram of the fault-slip data (Figure 9).
In the diagram, a fault-slip datum is represented by a small
arrow plotted on a stereonet. The position of the arrow in
the diagram indicate the pole to the fault plane, and the ar-
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Figure 9: Tangent-lineation diagram of the same data with Fig-
ure 6.

@ Slip Vector on Great Circle
Tangent-Lineation Diagram

Export Histogram to EMF
Export Misfits to Text File

Show Main Window

Figure 10: Items in the pop-up menu shown by a right-click on
the stereonet in the data window.

row points the slip direction of the footwall block [13]. A
lot of right gray arrows make an array on Figure 9 to show
theoretical slip directions. You can choose the expressions
in Figures 6 and 9 through the pop-up menu shown in Fig-
ure 10.

The results of the simulation that are illustrated on the
stereonet and histogram on the data window can be saved
in enhance metafiles. The angular misfits shown in the ta-
ble can be saved in a text file, also. Use the pop-up menu
shown in Figure 10 for those purposes.

[Enhance Factor] On the paired stereograms in the main
window, a great number of tadpole symbols are plotted.
Clusters of the symbols represent significant stresses for
given fault-slip data. The “Enhance factor” in the “Stress”
menu controls the number as follows in order to enhance
the clusters.

The main processor conduct stress inversion for the en-
tire k-element subsets from the number of N faults, so that
we have yC; optimal stresses. The multiple inverse method
uses a computational grid which includes Ng = 60,000 grid

.3) Designate by Mouse
Designate an &xis throueh Keyboard

Diepersion Factor 14 9
=== Tadpole Symbol 2 10
! Chanee Colors 1
fverage and Spread = 1123
14
15
Other ..

Figure 11: Enhance factor e can be changed through this menu.

points. The optimal stresses are approximated by the near-
est grid points, so that let m® be the number of optimal
stresses tied to the ith grid point. The post processor plots
a number of m® / max(es, 1) tadpole symbols on the paired
stereograms, where e is the enhance factor that you can
change its value from the “Stress” menu, and s is the stan-
dard deviation defined by

Ne

e z\"(;l— - Z [nl‘“ - 7n_]2

i=1

and

sy |
= — lm‘” db oo +m(NG)] i
N

The default value of e is set at 12, but can be an arbitrary
integer in the range 0 < e < 99. You can choose the inte-
gers from the menu item shown in Figure 11. The standard
deviation is shown in the middle of the status bar with the
prefix “Sd :”. For example, the standard deviation is 1.29
for the case of Figure 3.

Since the denominator of the fraction m)/ max(es, 1) is
greater than or equal to the unity, this fraction is smaller or
equal to m®. Accordingly, the tadpole symbols are thinned
out by this division to enhance clusters®. The total number
of tadpoles plotted on each stereograms is

m 4+ mWS)

max(es. 1)

N, =

The left most section in the status bar shows three numbers,
N, number of grid points with m® > 0 and Ng, which are
separated by slashes.

9This enhancing technique is simple, but the fact is that it spoils the
resolution of the multiple inverse method. The clusters should be iden-
tified without the thinning with the enhance factor. For this purpose, it
is necessary to find out clusters in the parameter space. We have tested
some techniques [6]. A future version of this software suite shall imple-
ment artificial intelligence techniques for clustering in a high dimensional
parameter space.
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Figure 12: Attributes of the tadpole symbols.

[Dispersion Factor] It is not easy to see each tadpole
symbols in a high density cluster, because the symbols lie
one above another. In that case, the cluster can be dispersed
around its center by choosing a larger “Dispersion Factor”
from the “Stress” menu. The default value of the factor is
2, and can be an integer between 0 and 3. If it is set at zero,
the symbols are plotted just at the points on the stereograms
corresponding to the computational grid points.

[Tadpole Symbol] Other than colors, the tadpole sym-
bols have several attributes. The tails help users to see the
correspondence between the clusters in the left and right
stereograms, but the tails are not necessary in some pur-
poses. The tadpole symbols have two size, large and small.
Large ones may look nice for publication purposes. These
options can be chosen from the menu item “Tadpole Sym-
bol” shown in Figure 12.

[Change colors] The color scheme for stress ratios can
be changed by clicking the “Change Colors” from the
“Stress” menu. The dialogue in Figure 13 appears on the
screen to show color palettes. The colors are indicated by
their RGB values between 0 and 255. There are two color
columns in the dialogue box. The left and right ones show
the old and new color palettes, respectively. Click a color
box in the right column to change the color. The palettes
have 11 colors. You can save the RGB values in a text
file with the extension “.pal” by clicking the “Save Palette”
button on the dialogue. We call such a file as a palette file.
You can load a palette file by clicking the “Load Palette”
button.

[Average and Spread] Choosing this item from the
“Stress” menu, the statistical parameters of the plotted
stress states are shown on a dialogue box (Figure 14). The
values indicated under the item “Average” are the principal
orientations and stress ratio of the average state of stress
for the plotted ones. The “mean stress difference” indicates
the spread of the tadpole symbols. See Appendix D for the

Colors
Old Mew
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0 . . 0 255 :é_l=nad Paleite
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1B 204 123 i |00 200 255
20 213 20 . 255 255 255 TSI
143 214 27 ‘ 255 200 200
3255 izl 265 150 150
{242 181 16 £ 242 100 100 t
45 102 15 [ [l |25 50 50 Cancel ;
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| i)
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Figure 13: The color scheme to indicate stress ratios can be
changed through this dialogue.

Statiztical parameters of plotted otress tensors B3

File Mame
sampledata.mid

Enhance Facior=12

Average
sigmal axis= 221.2 71.3
sigma3 axis= 3515 124
Phi = 0.44

Spread
mean siress difference = 0.575

Close Windowl

Figure 14: Dialogue box showing statistical parameters of the
stress states plotted as the tadpole symbols on the paired stere-
ograms.

details of the average state of stress and the mean stress
difference.

T Main Window (This Window)
Data Wiindow

4.3.4 Window menu

You can choose to put the main window on the data win-
dow or vice versa by clicking the “Window” menu. The
menu item is included in the menu bar on the main win-
dow. When the main window is hidden by the data window,

you can switch the windows by typing on your
keyboard.

et ebetan - sbiie Bl

e




PDF {Enelich
[#] PDF {Japanese?

Yersion

4.3.5 Help menu

There are three menu items in the “Help” menu. The first
and second ones call English and Japanese help files, re-
spectively, in the PDF format. This document is contained
in the English one. The third item is to show the version of
the post processor.

5 Sorting of faults

Given heterogeneous fault-slip data, stress states that are
compatible with the data are represented by clusters in the
paired stereograms. You may want to know the correspon-
dence between the stresses represented by the clusters and
faults. If the order of activations of fault sets was deter-
mined at an outcrop, the correspondence indicates the order
of the stresses.

For the fault sorting, calculate the angular misfits of the
faults for each of the stress states. It is possible that faults
with the small misfit angles were activated by the desig-
nated stress. The histograms in Figures 6 and 9 indicate
that there are two outliers with misfits greater than 90°.
This is the evidence that the two faults are incompatible
with the designated stress state and that the stress was not
responsible with the faults.

On the other hand, the tangent-lineation diagram in Fig-
ure 9 indicates that many of the given faults are parallel to
the principal stress planes, which are defined by two prin-
cipal stress axes. Those faults were difficult to be activated
by the stress, unless their friction cocfficient was very low
when they moved. The proximity of the fault and principal
stress planes indicates low slip tendency of the faults [3].

Stress inversion is based on the Wallace-Bott hypothe-
sis (Appendix B), saying that faults with the same attitude
and the same slip direction can be activated by different
stresses. Therefore, the fault sorting that we can do only
from those fault-slip data has obscurity. The misfit angle
and the slip tendency are the fuzzy clues to the sorting.

6 Directions and known bugs

6.1 Main processor

Avoid characters other than alpha-numeric ASCII charac-
ters for the directory names of this software package and

of fault-slip data. If the main processor finds something
wrong, the console window closes as soon as some error
messages are shown. To read the messages, launch the
main processor from the command line to keep the console
window active on the screen.

6.2 Post processor

e Data loading fails occasionally. Try to load the same
data again by clicking the “Open” from the File”
menu.

e If the post processor loads data files many times, the
program can get hung. In that case, (1) press the keys

and successively to terminate the pro-

gram, (2) and run the post processor again.

7 Future versions

Improved versions of this software suite will be published.
We have projects to improve the resolution of this method
and to develop software for the objective identification of
clusters without thinning with the enhance factor. For the
first purpose, the computational grid is being redesigned
[11, 12]. The K-means clustering. an artificial intelligence
technique, is adopted to the automatic and objective recog-
nition of clusters in the 6-dimensional parameter space [6].
With this technique, bedding tilt test for paleostress analy-
sis | 16] will be also improved [7].

U Appendix A: Data format

The main processor loads data files only with the “FDT”
format, which is explained below. Make a data file with
a text editor, spreadsheet or other program with the file
extension “.fdt”. Each data file is expected to contain a
set of data that were collected from one area and/or from
one stratigraphic horizon. The data file must be a plain
ASCII-text file containing one fault-slip datum per line of
the text (Figure 15(a)). We call data files with the FDT
format “FDT files”.

Data files with the FDT format have the following struc-
tures. Every line is composed of four values and one char-
acter and, if necessary, remarks. The first and second val-
ues are the azimuth and dip of a fault plane, where the az-
imuth points to the dip direction. The third and fourth val-
ues are the azimuth and plunge of fault striations. The char-
acter represents the sense of fault movement, and must be
one of “N”, “R”, “D” or “S”. These are the initials of nor-
mal, reverse, dextral and sinistral faults, respectively. Their
lower-case letters are also acceptable. The items in each
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P P [0°. 90°], respectively. The main processor neglects any j
az pl Saz Spil) $2h2e words and characters after the fifth item in a line (Figure |

(b) 15), so that the columns after the character indicating the

N shear sense can be used for remarks.

It is recommended to check your data file with the stere- |
onet software!® “SFSA”. The Windows software loads data i
files with the FDT format, and visualizes their contents E
with a stereonet. You can export the graphics as a metafile |
to other programs. Figure 15(b) was made with the soft- |
ware.

U Appendix B: Mechanism of the
multiple inverse method

The mechanism of the multiple inverse method is explained
briefly in this appendix. See [14] for details. |

. 3 - : . i
Figure 15: (a) Example of a data file. (b) Fault-slip data listed in WaRacesotthypathenin (Houlslip anabysisitoinfen(pa |

| (a). Lower-hemisphere, equal-angle projection. Numbers in open  Le0)stresses including the multiple inverse method is based ;
? circles indicate the line numbers in the list. on the Wallace-Bott hypothesis [2]. That is, although fault
‘ planes may of arbitrary orientation, the slickenside stria-

tions and the sense of shear indicate the direction of the

‘ maximum shear stress on the fault plancs. Lct o be the

i stress tensor that activates a fault with the unit normal 7.
Then, we have the traction at the fault surface, 7 = o - 2.
The normal and shear components of this vector are (/—1’- 7) n
and

S=I—(n-l)n.

10The software SFSA is available also from the author’s homepage. |
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Figure 17: Decreasing function f(d) used in the multiple inverse
method.

respectively. Therefore, we have the shear stress

)

Note that faulting is thought to occur to relieve this shear
stress. Consequently, the Wallace-Bott hypothesis says that
a fault slip is parallel to the direction of —§. Assuming a

-

e —
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=
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-
S=0 n.
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stress tensor o, we can calculate the theoretical slip direc-
tion with Eq, (1).

Classic stress inversion Since this direction is a function
of i and o (Eq. 1), we can determine o in the least-square
sense. In this inversion, the objective function to be mini-
mized is

S :_/-(d(l))+,..+'/'(d"\b))_ (2)

where d¥ is the angular misfit between the observed and
theoretical slip directions of the ith fault, and N is the num-
ber of faults, and f( ) is a decreasing function [1]. Figure
17 shows the graph of the function the main processor uses.
This inverse method uses the attitudes of fault planes, the
orientations of striations and slip senses. These are called
fault-slip data. As these are non-dimensional quatities, the
stress components cannot be determined but the optimal
principal orientations and stress ratio are determined.

The multiple inverse method This method was designed
specifically to seprate stresses from heterogencous fault-
slip data'!. Faults are usually sorted into homogeneous
groups on the basis of apparent relative chronology. How-
ever, the fault sorting is usually difficult. The method is
a numerical technique to separate stresses from heteroge-
neous data.

The optimal stress determined by the stress inversion
is represented by a point in four-dimensional parameter
space, because the principal stress orientations are repre-
sented by three Euler angles and the stress ratio is the

1A set of fault-slip data is called heterogeneous, if multiple stresses
were responsible for the fault movements.

11

remaining parameter. The present method uses computa-
tional grid distributed in the parameter space.

The method firstly makes k-element subsets from N
faults'?. The number of the subsets is yC;. The classic
stress inversion is applied to all the subsets, so that we ob-
tain a great number of optimal stresses, each of which are
represented by a point in the parameter space. Significant
stresses are, consequently, represented by the clusters of the
points. It is assumed that the stresses vote to their nearest
grid points. The integer m® defined in §4.3.3 is the score
that the ith grid point polls.

O Appendix C: Stress difference

In this document, we assume that stress tensors with the
same principal orientations and the same stress ratio repre-
sent the same state of stress. In other words, we define the
state of stress by those stresses.

Given two states of stress that are represented by the ten-
sors E};’ and @', their difference is quantified by stress
difference D [4], where

I , k ;
D= ;{(Au — A} +(Az — Asz) +(Asz —An)

+6(A12) + 6(Ans) + 6(A3:):}%-

1
and A;; (6";,

normalized so as to satisfy the two conditions, oy + 0> +

. JE )
= b—‘i;)) and o7; is the stress tensor that is
5’3 5= 0 and

Oct

Og

15N e g S S s L
3{(0'11—0':3)‘+(0'::—0'33)'+(0'33—0'n)'

s

+6(T12)" + 6(T23)" + 6(T32) }jl = L. (3)
The lefi-hand side of the last equation is the octahedral
shear stress of o7;. Normalized stress tensors are also called
reduced stress tensors.

The Wallace-Bott hypothesis predicts the same slip di-
rection for any fault under the stresses with the same nor-
malized ones. If D = 0, two stresses have the same state of
stress, and cause the same fault activity. The large the stress
difference the greater the difference between slip directions
under two stresses becomes. If two stresses result always
in opposite slip directions for any fault, then they are called
inverse stresses and D = 2. Itis seen that 0 < D <2 [4].

12The main processor accepts an integer in the range [2, 8] for the com-
bination number k. The stress inversion is an evenly determined and over
determined inverse problems if k = 4 and > 4, respectively. The choice of
k is arbitrary for the present method, but we recommend & = 5 for many
cases.
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